
Chapter 
7 Setting Up Non-Windows Applications

This chapter presents details about how to set up and run non-
Windows applications under Microsoft Windows 3.1. For 
information about creating program information files, see 
Chapter 8, “PIFs and PIF Editor.” For information about specific 
problems with running non-Windows applications, see Chapter 13,
“Troubleshooting Windows 3.1.”

Related information · Windows User’s Guide:  Chapter 7, “Non-Windows 
Applications,” and Chapter 8, “PIF Editor”; see also the 
background information on creating program groups and 
managing files in Chapter 3, “Program Manager,” and 
Chapter 4, “File Manager”

· Windows Resource Kit:  “APPS.INF” in Chapter 2, “The Windows 
Setup Information Files”; Part 2, “Configuring Windows 3.1”

· Glossary terms:  application, expanded memory, extended 
memory, grabber, PIF, virtual memory 

Contents of this chapter

About Applications......................................................................284
Setting Up PIFs and Program Items..............................................285

Setting Up a PIF......................................................................285
Setting Up Icons in Program Manager..................................287

Starting Non-Windows Applications with Windows..................288
Starting an Application When Starting Windows.................288
Starting an Application from the Desktop.............................289

Running Non-Windows Applications..........................................290
Running Applications in Standard Mode...............................290
Running Applications in 386 Enhanced Mode......................291
SYSTEM.INI Entries for Non-Windows Applications..............293

Tips for Running Non-Windows Applications............................294
General Tips...........................................................................294
Rebooting a Non-Windows Application................................294

 Windows Resource Kit



284 Part 3   Non-Windows–Based Applications

Notes on Running Non-Windows Applications....................295

Windows Resource Kit  



Chapter 7   Setting Up Non-Windows Applications 285

About Applications

You are likely to encounter two basic types of applications while 
running Microsoft Windows 3.1:  Windows applications and non-
Windows applications.

Windows applications are any applications that are designed to run
with Windows and that do not run without Windows.  All 
Windows applications follow similar conventions for arrangement 
of menus, style of dialog boxes, and keyboard and mouse use. You
might encounter these types of Windows applications:

· Applications designed for Windows 3.1. 

· Applications designed for Windows 3.0 or later versions. 
Windows applications can take advantage of Windows 3.0 
features and interact with other Windows applications.

· Applications designed for older Windows versions. 
Applications designed for Windows 2.x or earlier cannot run 
under Windows 3.1. When you attempt to run such an 
application, Windows displays a message advising you to get 
an updated version of that application. Your application 
manufacturers will be able to tell you if a Windows 3.x version
of their software is available.

“Non-Windows application” is used in the Windows Resource Kit 
as a shorthand term to refer to an application that is designed to 
run with MS-DOS but not specifically with Windows. Such 
applications may not be able to take full advantage of all Windows
features (such as memory management). There are two basic kinds
of non-Windows applications that you might encounter under 
Windows 3.1:

· Application software. Applications such as Lotus 1-2-3 and 
WordPerfect can be run under Windows in either standard or 
386 enhanced mode. A program information file (PIF) gives 
Windows the information it needs to run a non-Windows 
application.

· TSRs and other memory-resident software. Memory-
resident programs such as mouse drivers, network software, or 
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pop-up programs like Borland Sidekick are loaded into 
memory when you start them and are available while other 
applications are running. You can start memory-resident 
programs before you start Windows or while Windows is 
running. Such non-Windows programs also use a PIF if you run
them under Windows.

The next section of this chapter contains details about setting up 
non-Windows applications that you want to run under Windows 
3.1.

Windows Resource Kit  



Chapter 7   Setting Up Non-Windows Applications 287

Setting Up PIFs and Program Items

To run a non-Windows application, Windows uses a program 
information file (PIF) to run the application in the most efficient 
way. Windows needs to refer to PIF information because non-
Windows applications don’t use memory cooperatively in the ways
that Windows applications do, which can lead to insufficient-
memory problems.

A custom PIF contains specific information about running the 
application under Windows, including how much memory it needs
and how it uses system components such as the communications 
ports. If there isn’t a custom PIF for an application, Windows uses 
_DEFAULT.PIF.

You can set up a PIF for a non-Windows application in three ways:

· Install a PIF with Windows Setup.

· Use the PIF that came with your non-Windows application.

· Use PIF Editor to create a new PIF or to modify _DEFAULT.PIF, 
the default program information file. For details, see 
Chapter 8, “PIFs and PIF Editor.” 

Setting Up a PIF 

The Windows Setup program can install PIFs and icons for your 
non-Windows applications, either automatically during Windows 
setup or after Windows is installed. This is the best method for 
specifying a PIF, because Windows 3.1 includes data for creating a 
large variety of PIFs specially for popular non-Windows 
applications, as listed at the end of this chapter.

The Setup program gets the information it needs for a PIF by 
checking a file called APPS.INF, which is placed in the Windows 
SYSTEM subdirectory during installation. APPS.INF contains the 
recommended settings for many popular non-Windows 
applications. For details about the contents of APPS.INF, see 
Chapter 4, “The Windows Initialization Files.”
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If the APPS.INF file doesn’t contain information about your 
application, then Windows uses the _DEFAULT.PIF file to run the 
application. 
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To set up a PIF during Windows installation:

1. Run Windows Setup from the command prompt.

2. In the Windows Setup dialog box, select the Set Up 
Applications option.

3. When the Set Up Applications dialog box appears, select the 
applications from the box on the left that you want to run 
under Windows. Then choose the Add button.

4. When you have selected all the applications to be set up, 
choose the OK button. 

Windows creates PIFs for the applications you choose, and adds a 
program-item icon for each to the Applications group in Program 
Manager.

To set up a PIF after installing Windows:

1. Run Setup by choosing the Windows Setup icon from the Main
group in Program Manager.

2. From the Options menu in Setup, choose Set Up Applications.

If you don’t want Setup to search your entire hard disk for 
non-Windows applications, choose the Ask You To Specify 
An Application option.

3. Choose the OK button in the Set Up Applications dialog box. 
Windows Setup searches for applications and displays a list of 
those it finds.

4. Select applications from the box on the left that you want to 
add. Then choose the Add button, and choose the OK button. 

Windows Setup creates a PIF and adds a program-item icon for 
each application to the Applications group in Program Manager.
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Figure 7.1

Setup Applications dialog
box

To display this dialog, 
choose Set Up 
Applications from the 
Options menu in Windows
Setup 
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Some application manufacturers provide PIFs for their applications.
To find out if your application has a PIF, contact the manufacturer 
or search the application disks for a file with a .PIF filename 
extension. If a PIF came with your application, copy the file to the 
WINDOWS directory on your hard disk.

If there is a PIF for your application available through Windows 
Setup and another that came from your application’s manufacturer,
use the PIF from the manufacturer.

Setting Up Icons in Program Manager

When you use Setup to add PIFs for non-Windows applications, 
Setup automatically adds program-item icons to the Applications 
group in Program Manager. If you create or add a PIF for a non-
Windows application, you can also add a program-item icon for 
the PIF to Program Manager. For more information about how to 
set up a program item, see Chapter 3, “Program Manager,” in the 
Windows User’s Guide.

To add a PIF to a Program Manager group:

1. In Program Manager, select the program group where you 
want to add the icon for a PIF.

2. Choose New from the File menu. Select Program Item in the 
dialog box, and choose the OK button.

3. Type a description for the application in the Description box.

4. Specify the complete path and filename for the PIF in the 
Command Line box, including the .PIF extension. Then choose 
the OK button.

 

You can also create a new program item by dragging an 
application’s .PIF or .EXE file from the File Manager window to the
Program Manager window. The program item appears with the 
default MS-DOS Box icon. You must use the Properties command to
change this icon.
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Program Item Properties 
dialog box

To display this dialog, 
choose File Properties in 
Program Manager
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To alter the program-item icon for a PIF:

1. Select the PIF’s icon and choose Properties from the File menu 
in Program Manager.

2. Choose the Change Icon button in the Properties dialog box.

3. Choose an icon in the Change Icon dialog box. Or choose 
Browse and select other file choices. 

For example, change the filename to PROGMAN.EXE to display 
the icons available in PROGMAN.EXE. (You can use icons from 
any Windows application by typing its executable filename in 
this field.)

W Windows 3.1 includes a wide range of icons, displayed through
the MORICONS.DLL.

4. Scroll the view box and select the icon you want, then choose the 
OK button.

 

Starting Non-Windows Applications with Windows

You can start a non-Windows application at the command prompt 
when you start Windows, or start the application using either 
Program Manager or File Manager.
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Change Icon dialog box

To display this dialog, 
click Change Icon in 
the Program Item 
Properties dialog box
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Starting an Application When Starting Windows

To start a non-Windows application when you run Windows, do 
one of the following:

W · Add an icon for the non-Windows application to the Startup 
group in Program Manager. All applications in this group start 
automatically with Windows.
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· Or add the filename of the application or its PIF to the run= or 
load= entries in the [Windows] section of WIN.INI.

· Or, at the command prompt, type win with a command to run 
the application. For example, to start Windows and run 
Microsoft Word 5.5, at the command prompt type win word 
and press ENTER.

At the command prompt, you can use the program’s .EXE 
command with any switches, or you can use a .BAT file that 
changes the environment or runs TSRs before executing the 
program command.

After Windows starts, it looks for a .PIF file with the same name as
the executable program; if none is found, Windows uses 
_DEFAULT.PIF to run the non-Windows application.

Starting an Application from the Desktop

If you add an icon for a non-Windows application to a Program 
Manager group, you can start a non-Windows application by 
choosing its icon, just as you start any application.

The program-item icon can represent an .EXE, .PIF, .COM, or .BAT 
file that runs the non-Windows application. To see what the icon 
represents, select it and choose Properties from the File menu in 
Program Manager.

You can also use File Manager to start a non-Windows application
in the same way that you start a Windows application.

Tip    If you get an out-of-memory message when you start a non-
Windows application, there are a number of things you can do to 
offset the problem:

· Close or minimize any other applications you are running.

· Clear or save the contents of Clipboard.

· Set the Wallpaper option to None for the desktop.

· If you are running Windows in 386 enhanced mode, try 
running the non-Windows application in full-screen display 
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instead of in a window, and don’t allow any applications to run
in Background mode. To do this, edit the application’s PIF to 
make sure that Full Screen is selected and the Execution 
Background box is not checked.
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Running Non-Windows Applications

Windows runs non-Windows applications differently in standard 
mode and 386 enhanced mode.

Running Applications in Standard Mode

If you are running Windows in standard mode, a non-Windows 
application takes up the entire screen rather than running in a 
window. You can load more than one application at a time, but 
each application will run in full screen, and no application can 
process tasks in the background. This type of multitasking is called
“task switching.”

How Standard Mode Works with MS-DOS

When you run Windows in standard mode, it loads most of itself 
into extended memory. Then it creates an emulated MS-DOS real-
mode environment in extended memory, using DOSX.EXE. Because 
there can only be one DOSX environment at a time in standard 
mode, only one non-Windows application can run in it at a time.

The other files that support non-Windows applications in standard 
mode are the .2GR grabber file for your display adapter and 
WINOLDAPP.MOD (WinOldApp).

Application Swap Files and Standard Mode

In standard mode, each time you start a non-Windows application, 
Windows creates a temporary application swap file for that 
application. When you switch away from the application, 
Windows moves some or all of that application from memory to 
the application swap file. When data is moved from memory to the
swap file, the memory is then available for use by other 
applications. When you exit Windows, it deletes any application 
swap files created during that session.

The amount of hard disk space available determines how many 
application swap files Windows can create, and this in turn 
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determines how many non-Windows applications you can start 
before running out of memory. For more information about 
application swap files, see Chapter 14, “Optimizing Windows,” in 
the Windows User’s Guide.
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Running Applications in 386 Enhanced Mode

In 386 enhanced mode, you can run and view more than one non-
Windows application at the same time, because you can run most 
non-Windows applications in a window rather than being restricted
to full screen as in standard mode. You can move and size the 
window, shrink the window to an icon, and share information with
other applications by using the Clipboard.

When a non-Windows application is running under Windows in 
386 enhanced mode, you can use its Options menu for several 
tasks:

· Choose Edit to use commands for copying and pasting with the
Clipboard.

· Choose Fonts to select a display font for text in the window.

· Choose Settings to specify Multitasking and Display Options 
for this session. 

· Choose other standard Option menu commands to maximize 
and minimize the window or to switch tasks.

How 386 Enhanced Mode Works with MS-DOS

Each time you run a non-Windows application in 386 enhanced 
mode, Windows creates a virtual 8086 machine in which the 
application runs. This virtual machine is an emulation of a 
complete 8086 processor, including memory, I/O devices, and any 
TSRs, device drivers, and network software running when you 
started Windows.

In 386 enhanced mode, Windows remains in memory and active 
while running non-Windows applications. Each non-Windows 
application is treated as a multitasking “task” for timeslicing and 
device contention. Windows uses preemptive scheduling with non-
Windows applications, and uses non-preemptive scheduling with 
Windows applications. Windows and all current Windows 
applications are treated as a single preemptive task, and you assign
the priority for Windows in the 386 Enhanced dialog box in 
Control Panel. The non-Windows applications are each treated as 
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separate tasks, and you assign their priorities in their PIFs. The 
percentage of time spent on an application is its assigned priority 
divided by the sum of all priorities for Windows and all non-
Windows applications currently running.

The example in the following table shows how timeslicing is 
allocated between Windows and non-Windows applications. 

Virtual machine                      Setting           Processor time    

Windows in the foreground, with two non-Windows applications running:
System virtual machine 100 50%
MS-DOS VM #1 50 25%
MS-DOS VM#2 50 25%
Total value: 200 100%

Windows in the foreground, with four non-Windows applications running:
System virtual machine 100 32%
MS-DOS VM #1 50 17%
MS-DOS VM#2 50 17%
MS-DOS VM #3 50 17%
MS-DOS VM #4 50 17%
Total value: 300 100%

Non-Windows application in foreground, 
with Windows and another non-Windows application running in the background:
System virtual machine 50 25%
MS-DOS VM #1 100 50%
MS-DOS VM #2 50 25%
Total value: 200 100%

The files that support non-Windows applications in 386 enhanced 
mode are the .3GR grabber file for your display device and 
WINOA386.MOD (WinOldApp).

For information about virtual memory in 386 enhanced mode, see 
Chapter 5, “Windows 3.1 and Memory Management.” For 
information about how Windows handles concurrent requests for 
devices in 386 enhanced mode, see Chapter 5, “Control Panel,” in 
the Windows User’s Guide.
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Running Applications in a Window

You can only run non-Windows applications in a window if you 
run Windows in 386 enhanced mode. To get non-Windows 
applications to run in a window in 386 enhanced mode:

· Set the PIF’s Display Usage option to Windowed (not Full 
Screen), and set the Display Options correctly in the Advanced
dialog box.

· Or choose Settings from the Options menu while the 
application is running, and specify Windowed for Display 
Usage. This will work only for this session.

· Or press ALT+ENTER while the application is running in full 
screen. This will work only for this session.
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However, some non-Windows applications can’t run in a window, 
because they perform screen actions that are incompatible with the 
Windows display management features. Most of these applications
can run successfully in the Windows environment as long as they 
run in a full-screen display.

SYSTEM.INI Entries for Non-Windows Applications

Several entries in SYSTEM.INI affect how non-Windows applications
run. For details, see the descriptions of the specific entries in 
Chapter 4, “The Windows Initialization Files.”
Section Entries related to non-Windows applications

[Boot] 286grabber= 386grabber= 
[Standard] Int28Filter= Stacks=
[NonWindowsApps] CommandEnvSize= NetAsynchSwitching=

DisablePositionSave= ScreenLines=
FontChangeEnable= SwapDisk=
MouseInDosBox= 

The [386enh] section contains many entries that control how 
memory is allocated for virtual machines, 
and other memory management issues 
related to running non-Windows 
applications. The following entries will also 
affect performance and behavior for non-
Windows applications, sometimes 
overriding settings in application PIFs.

These entries in [386enh] control video memory and system 
memory:  AllEMSLocked=, AllXMSLocked=, 
ReserveVideoROM=, and ReservePageFrame=.

These entries in [386enh] control fonts in windows displaying 
non-Windows applications:  *WOA.FON= entries, 
UseROMFont=, and WOAFont=.

These entries in [386enh] control devices:  COMxAutoAssign= 
and MouseSoftInit=.

These entries in [386enh] control multitasking:  WinExclusive= 
and WinTimeSlice=. 
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These entries in [386enh] control screen refreshing and the display
of warning messages:

AutoRestoreScreen= BkGndNotifyAtPFault= VideoBackgroundMsg=
FileSysChange= WindowUpdateTime=
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Tips for Running Non-Windows Applications

This section contains tips for running non-Windows applications, 
in response to frequently asked questions directed to Microsoft 
product support specialists.

General Tips

Here are some general tips for running non-Windows applications 
and PIFs:

· Make sure you have properly configured the memory in your 
system, following the recommendations in Chapter 6, “Tips for
Configuring Windows 3.1.”

· If you can’t start a non-Windows application, first check to 
make sure the application runs under MS-DOS without 
Windows. If it can’t start or run under MS-DOS, it won’t run 
under Windows.

· If the application doesn’t access resources directly, use the 
_DEFAULT.PIF settings for the application’s PIF.

· If the application is resource-intensive due to graphics or 
memory requirements, make the following settings in the 
application’s PIF:
Full Screen: Checked
Exclusive: Checked
Display Options/Video Memory: High Graphics
Retain Video Memory: Checked

· If you get a not-enough-memory error while running Windows
in 386 enhanced mode, try changing the PIF settings for both 
the KB Required and KB Desired to -1. This will allocate all 
available conventional memory to your application.

Rebooting a Non-Windows Application

W If you can’t quit or complete other actions while running a non-
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· Check Flowcharts 5.3, 5.4, and 5.5 for troubleshooting tips if 
you experience application execution errors, general protection
faults, or other serious problems while running a non-Windows
application.
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Windows application, you can quit by pressing CTRL+ALT+DEL for a 
local reboot. This has the same effect as choosing the Settings 
Terminate command from the Control menu and, hence, can be 
risky.

Do not use a local reboot or the Settings Terminate command as a normal way to quit 
non-Windows applications. Use local reboot only in one of the 
circumstances described below.

If you press CTRL+ALT+DEL when an application is not responding to 
Windows commands to close or when the application is hung, an 
error message appears with options for closing the application. 
These are the four cases:

1. For a hung Windows application, you can press the ESC key to 
return to Windows, press ENTER to close the application, or 
press CTRL+ALT+DEL to reboot the system.

2. If a non-Windows application is hung and you press 
CTRL+ALT+DEL, you can then press the ESC key to cancel and 
return to the application, press ENTER to quit the application, or 
press CTRL+ALT+DEL to reboot the system.

3. If a non-Windows application is hung while running in the 
background and a Windows application is running in the 
foreground, you can press CTRL+ALT+DEL, then press any key to 
activate the non-Windows application or press CTRL+ALT+DEL to 
reboot the system.

If you press a key to activate the hung non-Windows 
application, the hung application appears in full screen. If you 
press CTRL+ALT+DEL again to quit this application, then you will 
see the error message described in case #2 above.

4. If you receive a message that the application is not responding 
to Windows commands to close (so that you must reboot the 
system), you can press any key or press CTRL+ALT+DEL again to 
reboot the system.

If you press CTRL+ALT+DEL when the current application is active 
(not hung), you will get a message warning you that the 
application is still running and asking if you want to proceed with 
rebooting.
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Notes on Running Non-Windows Applications

DPMI vs. VCPI for Non-Windows Applications

Windows 3.1 uses the DPMI specification to allow non-Windows 
applications to access extended memory on 80286 and 80386 
machines.

Some non-Windows programs use the Virtual Control Program 
Interface (VCPI) specification to access extended memory on 80386
machines. The performance of such applications depends on how 
closely the application follows the VCPI specification. Most 
programs that use the VCPI specification can run under Windows 
3.1.

For more details about DPMI and VCPI, see Chapter 5, 
“Windows 3.1 and Memory Management.”
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Running Applications That Require Expanded Memory

If your computer has an 80286 processor, you need an expanded 
memory board for applications that use expanded memory. Your 
CONFIG.SYS file must also contain a command line for the expanded
memory manager that comes with the board.

If your computer has an 80386 or higher processor, you can use 
EMM386.EXE to simulate expanded memory for non-Windows 
applications when you run Windows in 386 enhanced mode. In the
application’s PIF, you must also specify the amount of expanded 
memory the application requires.

For information about using expanded memory to run non-
Windows applications under Windows 3.1, see Chapter 5, 
“Windows 3.1 and Memory Management.”

Using a Mouse with Non-Windows Applications

W To use a mouse with non-Windows applications, you must have an
MS-DOS mouse driver that is loaded before you run Windows. 

Applications with PIF Data in APPS.INF

The applications listed in the following tables have entries in the 
[pif] section of APPS.INF. Windows Setup can use the information 
about these applications in [pif] to create custom PIFs for running 
the applications under Windows 3.1.
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If your mouse doesn’t work for non-Windows applications, check 
CONFIG.SYS and AUTOEXEC.BAT to be sure the MS-DOS mouse driver 
is installed properly. Windows 3.1 has its own mouse driver that 
must be installed if you want to use the mouse with Windows and 
with Windows applications.
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Applications with PIF data in APPS.INF

Access for MS-DOS HotWire Microsoft Quick C Reflection 1
ACCPAC BPI IBM Filing Assistant Microsoft Quick Pascal Reflection 2
ACCPAC Plus IBM Graphics Assistant Microsoft QuickBasic Reflection 4
APPLAUSE II 1.5 IBM Personal Editor Microsoft QuickBasic Ext. Reflection 7
Ashton Tate dBase IV IBM Professional Editor Microsoft Spell Reflection 8
AutoCAD IBM Writing Assistant 2.0 Microsoft Word 4.0 Reflex 2.0
AutoCAD (Batch File) Insight Microsoft Word 5.x Relay Gold
Autosketch 3.0 Interleaf 5 for MS-DOS Microsoft Works 2.0 Remote 2 call
 Kid Pix MultiMate 4.0 RightWriter
Borland C++ KnowledgePro (MS-DOS) Network Control Program RLOGINVT Utility
BRIEF 3.1 Lap-Link Pro Norton Utilities 4.5 RSH Utility
Close-Up 4.0 Learning Microsoft Works Norton Utilities 5/6.0 SAS 604
Crosstalk-XVI 3.71 Learning MS-DOS 3.0 Now! Scheduler
DataEase Learning MS-DOS Quick Ref OPTune SEDT Editor
 LetterPerfect Paradox Sethost Terminal Emulator
DataPerfect Lotus 1-2-3 3.1 Paradox 3.0 SideKick 1.0
DECnet Job Spawner Lotus 1-2-3form Paradox 3.5 SideKick 2.0
DisplayWrite 3 Lotus Access System PC Paintbrush IV Plus SideKick Plus
DisplayWrite 4 Lotus Agenda PC3270 SideKick Plus
DisplayWrite 5 LotusWorks 1.0 PCMAIL Utility Smartcom II
DisplayWrite Assistant LPQ Utility PC Tools - FileFind Soft Kicker
DM - Directory Maintenance LPR Utility PC Tools - View  
DrawPerfect Magellan 2.0 PC Tools Desktop 5.5l SPSS/PC+
DWDOS286 Managing Your Money PC Tools PCShell 5.5 SuperCalc 4.0
DWDOS386 Manifest PFS: Access SuperCalc 5.0
DWINFO2 Microrim R:Base 3.0 PFS: First Choice 3.0 Symphony 2.2
DWINFO3 Microrim R:Base 5000 PFS: First Choice 3.1 TeleMate
Extra! for MS-DOS Microrim R:Base Clout PFS: First Graphics TN Utility
Flight Simulator 3.0 Microsoft Adv. Basic PFS: First Publisher Turbo Pascal 6.0
Flight Simulator 4.0 Microsoft Basic PFS: Plan TurboTax
Formtool Microsoft Bookshelf PFS: Professional Network Ventura Publisher
Foxbase+ Microsoft C Compiler 5.1/6 PING Utility VMAIL Utility
FoxPro (Max. Cfg.) Microsoft Chart Procomm Volkswriter 3.0
FTP Utility Microsoft Fortran Compiler 5.1 Procomm Plus 1.1B WordPerfect
Framework III Microsoft Game Shop Prodigy WordPerfect Office
Freelance Plus 4.0 Microsoft Macro Assembler Professional File WordStar 2000
FTPSRV Utility Microsoft Mail Professional Write WordStar Professional
Generic CADD Microsoft Mail-Admin Programmer’s WorkBench WPOffice Calculator
Graphwriter Microsoft Make Utility Q & A Report Writer WPOffice Editor
GW BASIC Microsoft Multiplan Q-DOS 3 WPOffice File Manager
Harvard GeoGraphics Microsoft Multiplan QModem WPOffice NoteBook
Harvard Graphics 2.3 Microsoft Online 1.0 Quick Verse 2.0 Writer Rabbit
Harvard Graphics 3.0 Microsoft Pascal Compiler Quicken XTree Gold
Harvard Project Manager Microsoft Project Ready! XyWrite
Harvard Total Project Manager Microsoft QBasic
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More applications are listed in the ambiguous exe sections of 
APPS.INF. If you specify the executable filename for any of these 
applications, Setup will prompt you to specify which of these 
applications you want to install. Setup can also create custom PIFs 
for these applications.

Applications with ambiguous filenames listed in APPS.INF

Ashton Tate dBase III Microrim R:Base System V Quattro Pro 1.0
Autosketch 2.0 Microsoft Basic Compiler Quattro Pro 2.0/3.0
Brief 2.1/3.0 Microsoft Macro Assembler Symphony (Access)
cc:Mail for MS-DOS Microsoft QuickC w/ QASM PCTools Desktop 6.0
Crosstalk Mark 4 Microsoft Works 1.x PCTools Desktop 7.0
Framework II MS Quick Pascal Express PCTools PCShell 6.0
Freelance Plus 3.0 PFS: Professional Plan Turbo Pascal 5.0
Harvard Graphics 2.0 PlanPerfect WPOffice Calendar
Harvard Graphics 2.1 Procomm Plus XcelleNet X/Mail-MS-DOS
Learning MS-Word 5.0 Multimate OfficeWriter 6.2
Learning MS-Word 5.5 Norton Line Printer Paradox SE
Lotus 1-2-3 2.3 OfficeWriter PCSA Mail
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